Implementing Model Driven Architecture

Using Enterprise Architect

MDA in Practice
Cephas Consulting Corp.

Implementing Model Driven Architecture Using Enterprise Architect

MDA in Practice
January 2010
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>5</td>
</tr>
<tr>
<td>Trademarks</td>
<td>5</td>
</tr>
<tr>
<td>Prerequisites</td>
<td>5</td>
</tr>
<tr>
<td>Prerequisite Paper 1, Fast Guide</td>
<td>5</td>
</tr>
<tr>
<td>Prerequisite Paper 2, Features</td>
<td>5</td>
</tr>
<tr>
<td>Background Prerequisites</td>
<td>5</td>
</tr>
<tr>
<td>The Enterprise Architect solution for applying MDA</td>
<td>6</td>
</tr>
<tr>
<td>The Tool</td>
<td>6</td>
</tr>
<tr>
<td>The Company Behind the Tool</td>
<td>6</td>
</tr>
<tr>
<td>A look under the covers</td>
<td>7</td>
</tr>
<tr>
<td>Creating and Modifying Transformation Templates</td>
<td>7</td>
</tr>
<tr>
<td>Building and leveraging UML profiles</td>
<td>9</td>
</tr>
<tr>
<td>Creating MOF models</td>
<td>11</td>
</tr>
<tr>
<td>Defining constraints in OCL</td>
<td>12</td>
</tr>
<tr>
<td>MDA by example</td>
<td>14</td>
</tr>
<tr>
<td>Base Platform Independent Model (PIM)</td>
<td>14</td>
</tr>
<tr>
<td>Configuration options</td>
<td>15</td>
</tr>
<tr>
<td>Capitalize attribute names for properties</td>
<td>15</td>
</tr>
<tr>
<td>Define target language collection mappings</td>
<td>16</td>
</tr>
<tr>
<td>Define the default database</td>
<td>16</td>
</tr>
<tr>
<td>Selecting the transformation template(s)</td>
<td>17</td>
</tr>
<tr>
<td>Running the transformation(s)</td>
<td>18</td>
</tr>
<tr>
<td>The target C# model</td>
<td>20</td>
</tr>
<tr>
<td>Generating the C# implementation code</td>
<td>20</td>
</tr>
<tr>
<td>The target Java model</td>
<td>22</td>
</tr>
<tr>
<td>Generating the Java implementation code</td>
<td>22</td>
</tr>
<tr>
<td>Generating an EJB entity model</td>
<td>24</td>
</tr>
<tr>
<td>Generating a data model</td>
<td>25</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Generating an XML schema model</td>
<td>28</td>
</tr>
<tr>
<td>Generating a WSDL model</td>
<td>30</td>
</tr>
<tr>
<td>Generating a Unit Test model</td>
<td>34</td>
</tr>
<tr>
<td>In Conclusion</td>
<td>35</td>
</tr>
<tr>
<td>Additional information</td>
<td>36</td>
</tr>
<tr>
<td>About SPARX Systems</td>
<td>37</td>
</tr>
<tr>
<td>About Cephas Consulting Corp.</td>
<td>38</td>
</tr>
</tbody>
</table>
Overview

This tutorial serves as a practical guide for using Enterprise Architect (EA) to implement the MDA approach. The tutorial first takes an under-the-covers look at the EA MDA features, and then it uses a concrete example to take you through the transformation process step by step. The tutorial specifically covers:

- Tool setup, including creating or customizing transformation templates.
- PIM-to-PSM transformations.
- PSM-to-PSM transformations.

Trademarks

OMG™, Object Management Group™, UML™, Unified Modeling Language™, MOF™, Model Driven Architecture™, MDA™, OMG Model Driven Architecture™, OMG MDA™ are trademarks of the Object Management Group. All other products or company names mentioned are used for identification purposes only, and may be trademarks of their respective owners.

Prerequisites

In order to facilitate the flow and understanding of this tutorial, we offer the reader two companion papers which contain required information in order to reap the full benefits of this tutorial and MDA in general.

Prerequisite Paper 1, Fast Guide

For an introduction to general MDA concepts, please see the companion paper "The Fast Guide to Model Driven Architecture", a quick reference for MDA starters.

Prerequisite Paper 2, Features

In the companion paper, "Model Driven Architecture with Enterprise Architect", EA’s features are measured against our set of MDA requirements, and the tool specific MDA implementation features are analyzed in terms of compliance and practical usage.

Background Prerequisites

Leveraging the essence and power of MDA requires the practitioner to be well-versed in advanced topics that are part of the MDA arsenal. This tutorial shows how UML profiles, MOF meta-modeling and OCL constraint specifications are applied in the delivery of a full MDA solution. For information about these topics, a good place to start is the OMG Website at www.omg.org.
The Enterprise Architect solution for applying MDA

The Tool

*Enterprise Architect* is a mature UML 2.0 based modeling tool for the Windows platform (with a version for Linux running under *Cross-Over Office*) which has a decade of commercial history behind it, and a track record of fast evolution and impressive innovation.

The Company Behind the Tool

Sparx Systems has at numerous times stated their strong commitment to MDA and its underlying OMG standards such as UML, MOF and XMI. Its mission statement is quoted here:

> To provide an affordable, high-quality, team based modeling environment founded on the UML 2.0 specification, with comprehensive support for model to model transformations as well as model driven generation of common development artifacts such as documentation, source code, test scripts, deployment descriptors, XML schemas, database schemas, etc.

As will be illustrated below, *Enterprise Architect* offers a number of features targeted at MDA driven development, including a model to model transformation engine, allowing modelers to target multiple platform specific models from a single PIM – and to synchronize PIM changes into each PSM on demand. The built-in transformation templates include mappings to C#, DDL, EJB, Java, JUnit, NUnit, WSDL and XSD (XML Schema).
A look under the covers

Let us take a closer look at how Enterprise Architect implements MDA features.

The core MDA component in EA is a template based transformation engine that generates PSM elements from a PIM source. Templates are one of the ways for expressing transformations endorsed by the official MDA guidelines (please refer to the companion white paper Model Driven Architecture with Enterprise Architect.) These customizable MDA transformation templates use an approach and syntax similar to the EA code generation templates.

The screen shots included below were captured with an early version of EA, but are still pertinent as of release 7.5.

Creating and Modifying Transformation Templates

The editor allows one to view and/or modify the predefined transformation templates (in this example diagram an EJB Session template), as well as to create new ones.
The general principle is quite simple: EA provides access to the various elements (classes, attributes, operations, etc.) of the UML source model being processed. The scripting language defines the rules by which properties of each source element can be copied and/or transformed into a corresponding target model element. The mapping does not have to be one-to-one: new target elements can created as needed. EA also constructs internal bindings between each target PSM and its source PIM. This is essential for allowing iterative forward synchronization from the PIM to the PSM, adding or deleting features as required. For example, adding a new attribute to a source class will result - during forward synchronization - in a new column being added to the corresponding table element in the target data model. Element features in the target model which were not originally generated by the transformation process are not deleted or affected in any way. Note that these references between source and target elements are not visible to the user (i.e. they are neither instances of UML associations nor instances of what EA terms cross references).

Transformation marks, typically in the form of stereotypes or tagged values, can be used inside the script to drive the transformation process as shown in the following examples.

Snippets from templates illustrating the use of marks to drive transformations:

```%if classStereotype=="enumeration"%
  stereotype="enumeration"
%else%
  stereotype="XSDcomplexType"
%endIf%
```

And:

```$qualifers = %opTag:"EATypeQualifiers"% %if $qualifers != ""%
  %REPLACE($qualifers","","::")%
%endIf%
```

Please refer to the example further down in this document for a detailed description of the process required to take a sample platform independent model (PIM) and transform it into a number of different platform specific models (PSM).
**Building and leveraging UML profiles**

Sparx provides a list of commonly used UML profiles, some of which are freely available for download from their Website (http://sparxsystems.com.au/resources), in particular profiles for business, presentation, process and XML modeling. Many other profiles are built-in to the default installation set (the list will vary depending upon the tool edition purchased).

External profiles, including custom ones, can be loaded into the Resources view of the tool and from there made part of the standard toolbox section.

The following example shows a model leveraging the Software Process Engineering Metamodel (SPEM) profile.

In the context of MDA, such profiles can be used as a basis for creating platform independent models with the necessary stereotypes and other marks to drive the later transformation into platform specific models.
The user can also create custom profiles by extending the UML metamodel with new stereotype definitions. Tagged values and other features can then be associated with these stereotypes. EA provides the necessary interfaces for this purpose in a dedicated toolbox section:

The following diagram shows a custom UML profile for creating XML DTD models.
Creating MOF models

EA supports the ability to create MOF models and export them for storage into an external Metadata Repository (MDR) tool such as NetBeans. Supported MOF versions are 1.3 and 1.4.

MOF models are often used to create domain specific modeling languages (DSL) which can not be properly defined either in UML itself, or via the UML profile extension capability. Such user defined metamodels can then operate at the same meta level as UML.

The concepts of the DSL can be modeled in EA using the standard UML class diagram interface, but with a limited set of metamodel constructs defined by MOF (Package, Class, Enumeration and Primitive).

EA provides a dedicated area of its toolbox to build MOF-based metamodels, such as the network graph DSL example shown here.

Note that the creation of an instance model based on this MOF metamodel is currently not supported by EA.
Defining constraints in OCL

OCL syntax can be used almost everywhere UML constraints can be specified (class or attribute invariants, operation pre- or post-conditions, activity constraints, action constraints, etc – but currently not on messages or control flows). The syntax validation occurs automatically when saving the constraint.

EA also supports the ability to validate the OCL statements against the model itself, meaning to verify beyond just the syntax that the OCL statement is expressed correctly in terms of actual model elements, and that the kind of validation syntax that it uses corresponds to the actual data types defined for these elements: numbers, strings, collections, etc.

As of this writing this validation is restricted to elements and relationships only (typically OCL statements starting with the string ‘INV:’), and does not cover Operation level pre- and post-conditions.

OCL validation can be enabled or disabled in the Model Validation Configuration dialog, accessible from the Main Menu by selecting:

Project → Model Validation → Configure...
Note the three separate line items covering OCL conformance:

Validation can be operated against a single UML element, a diagram, a package hierarchy, or the entire model. The results are displayed in the *Output* window.
MDA by example

Starting from a simple platform independent model, the remaining pages illustrate a number of mappings to platform specific models using the default transformation templates defined in Enterprise Architect.

**Base Platform Independent Model (PIM)**

In this example the base PIM is void of any transformation marks (special stereotypes or tags): all of the transformation rules used are embedded inside the default templates.

Please note:

- The use of generic data types in this model: Integer, Long, Boolean and String. These data types will be mapped automatically by the transformation template using the CONVERT_TYPE macro (refer to the EA User Documentation for details).
To automatically map more complex data types, such as a Date for example, a customization of the transformation template may be required. Likewise for attributes where the multiplicity is greater than 1 (or which are marked as collections) since these settings are often ignored in the default templates.

The attributes for which accessor & mutator operations are desired as output results (also called properties), for example in Java and C#, should be scoped as public in the generic model. The transformation templates will automatically convert the attribute to private scope in the target model, as well as create the expected get() and set() operations. To avoid this behavior, mark the attribute as private in the PIM.

The transformation templates typically ignore the marking of an attribute as readonly via the derived or constant flags - cases in which only an accessor operation should be generated, and not a mutator. To get around this issue, mark the attribute as private and either:

- Create a manual accessor operation.
- Mark it as a read-only property inside the PIM (see the bookCount derived attribute in the Store class above for an example).
- Customize the template using the attConst or attDerived macros.

**Configuration options**

Additional configuration options (using the Tools → Options menu item) which can help with certain transformation processes later on are:

**Capitalize attribute names for properties**

This is especially important for transformations into the C# language, to avoid naming conflicts.
Define target language collection mappings

Many target platforms (Java, C#, C++, Visual basic, etc.) define utility classes which can be used to hold different kinds of collections (e.g. lists, maps, bags). When properly configured in EA, these classes will be used by the transformation templates to automatically map UML association ends with a multiplicity > 1 to the appropriate collection type.

The example below shows a possible mapping for the Java target platform.

Define the default database

The database schema (DDL) transformation template uses the default database setting as its target environment, so it is important to initialize it properly via the toolbar or the options interface (Tools → Options → Code Editors):
Selecting the transformation template(s)

With the package holding the PIM classes selected in the Project View, the Model Transformation dialog can be invoked to designate the transformation targets:

- Note that elements can also individually transformed via their context menu (right click), by selecting the Transform Selected Element(s) option.
The major steps in using the above dialog interface are:

- Selecting one or more of the elements in the source package as appropriate for the intended transformation(s).
- Selecting a target destination PSM package for each transformation.
- Selecting the kind(s) of transformation. In this example Java and C# are chosen as two platforms which can be targeted from the same set of source elements.
- Setting *Generate code on result*: after the very first transformation, when the target packages and namespaces have been created and the code generation target pathnames defined, subsequent transformations can use this option to automatically invoke the code generation feature for the target classes corresponding to the selected source classes.
- Setting *Perform transformations on result*: likewise, this option can be used to automatically invoke previously defined transformations on the target model, thus allowing a “chain of transformations” to occur from a single user command.
- Defining an intermediate file to capture the output of the transformation engine. This feature is invaluable when debugging transformation templates, or when creating custom transformations. This file holds the properties of each UML element before its actual creation in the target model.

**Running the transformation(s)**

EA creates each target PSM package (if it does not exist already) with all of the generated elements under it. A class diagram showing these elements is constructed by default (or updated if created previously):
The package names “C# Model”, “Java Model”, and other PSM target package names are currently hard coded in each of the templates. By default EA marks these top level packages as namespace roots, so they are not part of the target namespace.
The target C# model

The following PSM is the result of the above transformation (diagram objects were re-arranged for clarity):

Note the following transformation results:

- Conversion of the generic data types to C# types.
- Conversion of the public attribute scopes back to private.
- Creation of the C# properties, including for the navigable UML association ends with a mapping to the appropriate collection class.

Generating the C# implementation code

The generated C# PSM can now be used as the source model for a transformation into actual implementation code, via the default code generation template of EA.
The resulting source code can now be further edited, compiled and built, either using the editor provided by EA, or by using an external IDE such as Visual Studio (Sparx provides an extension to EA using the MDG link technology for close integration with Visual Studio.)

http://www.sparxsystems.com/products/mdg_vs.html
The target Java model

This Java PSM is also the result of the above transformation (again diagram objects were re-arranged for clarity):

Note the following transformation results:

- Conversion of the generic data types to Java types.
- Conversion of the public attribute scopes back to private.
- Creation of the Java properties (accessors/mutators), including for the navigable UML association ends with mapping to the appropriate Java collection class.

Generating the Java implementation code

The generated PSM can now be used as the source model for a transformation into Java implementation code, via the default code generation template of EA. This code can then further be edited, compiled and built using an appropriate IDE such as Eclipse (Sparx provides another tool extension for close integration with Eclipse.)

For details please visit:

```java
public class Store implements ManageBooks {
    private long bookCount;
    /* Some comments about the Name */
    private String name;
    private java.util.ArrayList books;

    public Store() {
    }

    public void finalize() throws Throwable {
    }

    /* void Store::addBook(Book book) { } */
    /* @param newBook */
    public void addBook(Book newBook) {
        //Initial code
    }

    public long getBookCount() {
        return bookCount;
    }
}
```
Generating an EJB entity model

Next, as part of the underlying middleware for this example, an EJB Entity PSM model is generated. In our example PIM model there are no good candidate classes for generating EJB Session beans, but the output model is similar to the Entity bean PSM (without the primary key element).

The following diagram presents an overview of all the PSM model elements generated by this transformation.

Here we view in more detail the elements created for one of the source PIM classes, in accordance with the EJB specification:
**Generating a data model**

In the information viewpoint of the system one may wish to create a PSM model of the data elements defined by the PIM, as a basis for creating a database schema. In this transformation EA leverages its built-in UML profile for data modeling.

For background information refer to:


Note the mapping of the data types - in this example the default database was set to SQL Server 2000 – as well as the addition to the target model of both primary and foreign keys.

From that target model EA can generate the actual DDL, as illustrated below.
What follows is a snapshot of the resulting DDL script.
CREATE TABLE BookPublisher ( 
  bookID int DEFAULT , 
  bookPublisherID int DEFAULT NOT NULL, 
  name text DEFAULT 
)

COMMENT ON TABLE BookPublisher
  IS '#include "Book.h"

CREATE TABLE Store ( 
  bookCount bigint, 
  bookID int, 
  name text, 
  storeID int NOT NULL
)

ALTER TABLE Book ADD CONSTRAINT PK_Book 
  PRIMARY KEY (bookID)

ALTER TABLE BookPublisher ADD CONSTRAINT PK_BookPublisher 
  PRIMARY KEY (bookPublisherID)

ALTER TABLE Store ADD CONSTRAINT PK_Store 
  PRIMARY KEY (storeID)

ALTER TABLE Book ADD CONSTRAINT FK_Book_BookPublisher 
  FOREIGN KEY (bookPublisherID) REFERENCES BookPublisher (bookPublisherID)

ALTER TABLE Book ADD CONSTRAINT FK_Book_BookStore 
  FOREIGN KEY (storeID) REFERENCES Store (storeID)

ALTER TABLE BookPublisher ADD CONSTRAINT FK_BookPublisher_Book 
  FOREIGN KEY (bookID) REFERENCES Book (bookID)

ALTER TABLE Store ADD CONSTRAINT FK_Store_Book
Generating an XML schema model

Yet another powerful transformation, especially in the context of system integrations, is a PSM model containing the XML Schema representation of the PIM data elements:

The current transformation rules simply mark all classes (other than enumerations) as XSDComplexType. Also note that mapping of the data types does not occur at this transformation stage, but rather during the generation of the XML schema itself.
Which produces the actual XML Schema file:

```xml
<?xml version="1.0" encoding="ISO-8859-1"?>
  <xs:element name="Book" type="Book"/>
  <xs:complexType name="Book">
    <xs:annotation>
      <xs:documentation>Some book class level comments</xs:documentation>
    </xs:annotation>
    <xs:sequence>
      <xs:element name="author" type="xs:string"/>
      <xs:element name="IsInPrint" type="xs:boolean"/>
      <xs:element name="title" type="xs:string"/>
      <xs:element name="year" type="xs:integer"/>
      <xs:element name="store" type="store" minOccurs="0"/>
      <xs:element name="publishedBy" type="BookPublisher"/>
    </xs:sequence>
  </xs:complexType>
  <xs:element name="BookPublisher" type="BookPublisher"/>
  <xs:complexType name="BookPublisher">
    <xs:annotation>
      <xs:documentation>Include "book.xsd"</xs:documentation>
    </xs:annotation>
    <xs:sequence>
      <xs:element name="name" type="xs:string"/>
    </xs:sequence>
  </xs:complexType>
  <xs:element name="store" type="Store"/>
  <xs:complexType name="Store">
    <xs:annotation>
      <xs:documentation>Some class level comments</xs:documentation>
    </xs:annotation>
    <xs:sequence>
      <xs:element name="bookCount" type="xs:long"/>
    </xs:sequence>
  </xs:complexType>
</xs:schema>
```
Generating a WSDL model

The transformation into WSDL provides designers and architects with a mechanism for quickly transforming abstract interfaces into a complete Web Service specification.

The starting point is typically an interface class such as ManageBooks in our example.

![Diagram of WSDL components]

The following diagram illustrates the artifacts produced:

- The operation input arguments mapped into WSDL request messages (there are no output or result arguments in this example).
- The operations themselves mapped into a WSDL port type and its corresponding binding using the request messages.
- The creation of an abstract service representing the interface.

From the root package, the actual WSDL file can now be generated:
... and the resulting file edited for validation and further processing:
<definitions name="Bookstore">
  <types/>
  <message name="addBookRequest">
    <part name="newBook" type="Book"/>
  </message>
  <message name="removeBookRequest">
    <part name="bookRef" type="Book"/>
  </message>
  <portType name="ManageBooks">
    <operation name="addBook">
      <documentation>void Store::addBook(Book book) { }</documentation>
      <input name="addBookRequest" message="addBookRequest"/>
    </operation>
    <operation name="removeBook">
      <input name="removeBookRequest" message="removeBookRequest"/>
    </operation>
  </portType>
  <binding name="ManageBooks" type="ManageBooks">
    <documentation style="document" transport="http://schemas.xmlsoap.org/soap/http"/>
    <operation name="addBook">
      <documentation>void Store::addBook(Book book) { }</documentation>
      <input>      <body use="literal"/>
    </input>
    </operation>
    <operation name="removeBook">
      <input>      <body use="literal"/>
    </input>
    </operation>
  </binding>
</definitions>
**Generating a Unit Test model**

So far all of the above transformations have started from a platform independent source model to produce a platform specific one. Next we see an example where a PSM takes on the role of a PIM with regards to a further downstream transformation. In particular we take the Java model we created earlier and run it through the MDA transformer to obtain a JUnit test model, effectively setting up a chain of transformations.

The test code skeletons can now be generated from the resulting classes, edited in an appropriate IDE to add the test logic, and executed after loading them into the JUnit framework.

A similar transformation capability is available to generate NUnit test classes from C# source models.
In Conclusion

This tutorial covered the fundamentals of the MDA approach as implemented by Enterprise Architect. Because of the vast amount of possibilities present with MDA, such a tutorial can only serve as an illustration and starting point for a full adoption of the approach across the organization. Being a fairly young standard, MDA and its supporting OMG specifications (e.g., UML, MOF, QVT…) will invariably be subject to further evolution and maturation. This makes tool selection a bit more difficult for a number of reasons.

First, one should avoid tool vendors that offer a black box style “MDA engine” solution because this will constrain your organization to whatever canned transformations the tool offers. This involves the typical flexibility versus availability tradeoff: until the dust has settled in the MDA arena, it is better to select flexibility over canned solutions. Enterprise Architect fares very well in that respect because it offers a set of built-in transformation templates but also allows the creation of custom ones.

Second, although tools are essential to model-driven-design, it is best not to look at MDA only through the prism of tool capabilities. Much more critical factors to a successful adoption are the training of the MDA practitioners and the adjustment of the development processes.
Additional information

EA MDA information

- Summary of MDA resources and MDA style transformations
- Overview of writing transformations

Companion Papers

- The Model Driven Architecture Brief for Managers
- The Fast Guide to Model Driven Architecture
- Model Driven Architecture with Enterprise Architect
About SPARX Systems

Established in 1996 by Geoffrey Sparks, Sparx Systems is an Australian company based at Creswick, near Ballarat, Victoria. With over a decade invested in the development of Enterprise Architect, the company's motivated team of engineers are dedicated to the ongoing development and support of software tools, object-oriented methodologies and CASE tools.

Sparx Systems aims to satisfy the growing needs of the software and business development industry by providing immediate delivery and ongoing support of affordable, productive and user-friendly business/system design software.

Sparx Systems believes that a complete modeling and design tool should be used throughout the full process/software lifecycle. Our subscription plan reflects this, and our belief that "life-cycle" software should be as dynamic and modern as the systems you design and maintain.

Sparx software is intended for use by analysts, designers, architects, developers, testers, project managers and maintenance staff - almost everyone involved in a software development project and in business analysis. It is Sparx Systems' belief that highly priced CASE tools severely limit their usefulness in a team, and ultimately to an organization, by narrowing the effective user base and restricting easy access to the model and the development tool. To this end, Sparx Systems are committed to both maintaining an accessible pricing model and to distributing a 'Read Only' (EA Lite) version of EA for use by those who only need to view modeling information.

Sparx software is utilized by a wide variety of companies ranging from large, well-known, multinational organizations to many smaller independent companies and consultants. The Sparx discussion forum confirms a solid and active user base.

Sparx software is used for the development of various kinds of software systems for a wide range of industries, including: aerospace, banking, web development, engineering, finance, medicine, military, research, academia, transport, retail, utilities (gas, electricity etc.), electrical engineering and many more. It is also used effectively for UML and business architecture training purposes in many prominent colleges, education facilities and universities around the world.

Website: http://www.sparxsystems.com

Sparx Systems can be contacted at the following email addresses:

Sales inquiries: sales@sparxsystems.com.au
Support inquiries: support@sparxsystems.com.au
About Cephas Consulting Corp.

Since 2001, Cephas Consulting Corp. has been active helping its corporate clients introduce state of the art information technologies. We offer expertise in the areas of:

- Modeling business applications using object oriented techniques.
- Building distributed component infrastructures.
- Introducing formal software development processes.
- Migrating development organizations into Model Driven Architecture (MDA).
- Providing advanced UML/MDA training and mentoring.

Cephas specializes in introducing modeling practices into organizations via training and mentoring. The team of consultants and architects at Cephas draw on many years of experience to offer a one-stop solution addressing all aspects of managing the enterprise meta-data.

- Training & mentoring from beginner to expert level.
- Migrating meta-data out of legacy environments.
- Training for onsite guardianship of the development environment.
- Customizing the modeling tool in order to respond to unique client requirements.
- Providing expert level support and maintenance.

Cephas Consulting has the required expertise to lead organizations into the use of Model Driven Architecture. As early adopters we have successfully helped a number of clients implement MDA. We are also thrilled to work as OMG members on expanding the mind share of MDA in the marketplace, because we believe it is ideally suited to deal with the challenges of managing complex software development in times of rapid technology obsolescence.

Our highest commitment is in achieving success through quality, and we take pride in the accomplishments of our clients.

Website: [http://www.cephas.cc](http://www.cephas.cc)
General inquiries: cephas.contact@cephas.cc
Author inquiries: frank.truyen@cephas.cc
EA license purchase inquiries: cephas.license@cephas.cc